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[ 2-1 GOWIN MCU Designer 55 & [

{4 C/C++ - em1_led/USER/main.c - GOWIN MCU Designer

File Edit Source Refactor Navigate Search Project Run Window Help

Hulid |- R -Bin| il AE=R A CRCR AR
[?5 Project Explorer 23 98 = 8  [@minc 2
13 bk with_enroll_manufacture_GW1NSER 4C ~ m = Copyright (C) 2014-2021 Gowin Semiconductor Technology €o.,Ltd.[]

13 bk _with_no_enroll_ GWINSER_4C
3 cm1_ahb2_exi

3 cml_apb2_exi

@ cml_can

3 cmi_ddr3

L3 cmi_dualtimer

13 em1_sthernet

15 #include "GOWIN_M1.h"

18 void GPIOInit(void);
19 void delay(_I0 uint32_t nCount);

int main(void)
{

0 cm fatfs SystemInit();
@ cm1 freertos GPTOINIt();
0 cml_ize hile(1)
3 cm1_keyscan !
v 5 cml_led GPI0_WriteBits(GPIOR,OXE);
4 Binaries delay(4333000);
[l Includes GPI0_WriteBits(GPIO@,@xD);
(= CORE delay(4333060);
& Debug GPIO_WriteBits(GPIOB,BxB);
(= PERIPHERAL delay (4333060);
(= STARTUP
GPI0_liriteBits(GPIOB,0x7);
(& SYSTEM delay(4333068);
~ (= USER }
GOWIN_M1_conf.h ¥
[ GOWIN_M1 jtc e
GOWIN_M1_ith
[& maine & Consale 2

GOWIN_M1 flashld
3 cm1_led boot embflash

3 cm1_mm

CDT Build Consele [em1_led]

Invoking: Cross ARM GNU Print Size
arm-nonc-eabi-size --format=berkeley *cml led.elf”
3 cml_nvic text  data bss dec  hex filename
@ em1_psram 624 1088 68 7396  lced cml led.elf
& cm_retarget Finished building: eml led.siz

3 cm1_retarget boot_embflash

B cmi_retarget_exddr3 17:01:07 Build Finished (took 75.567ms)
O eml_rte v <

5 em1_led
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GOWIN_M1h

GPIOInit(void) : void
delayfvolatile uint32 t)
main(veid) : int
GPIOInit(void) : void
delaytvolatile uint32 t)
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Gowin_EMPU (GW1NS-4C) ARM Cortex-M3

GW1NS-4C
GW1NSR-4C
GW1NRSER-4C
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GW1N-9
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GW2A-18C
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Gowin_EMPU_M3 ARM Cortex-M3

GW2A-55
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RISC-V

Gowin_PicoRV32
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3 GOWIN MCU Designer %% 3BT

3 GOWIN MCU Designer &Z3%

3.1 T{THE
Windows: Win7/8/10(64bit)

3.2 HTH

GOWIN MCU Designer Z %41, GMD_V1.1.exe Al & 5w = §44
BT FHE: www.gowinsemi.com.cn/prodshow.aspx
E!
BAREET, TAREMEMIEE R,

33 BHRE

|

e %4 GOWIN MCU Designer B {f#1, I 360 8411 8 81 S A B

o MR WA SRR A TR LU A I SO AR

o INFHLEHRA GOWIN MCU Designer #ft:, @ilE# B MRAZ G, FRes,
o INRRIRTR LA Sy, AR B iR 31 FiR.

%% 3-1 Components to Install

Components iR e

GOWIN MCU Designer | GOWIN MCU Designer %t

GUI BT P i PATICHE GMD_V1.1.exe

SEGGER J-Link Driver SEGGER J-Link 3 zh#44: -

Olimex Debug Driver Olimex 17 F 28 X Bl AT CrE

GMD\driver\zadig-2.5.exe
3.3.1 GMD B REHiE
%% GOWIN MCU Designer %, H3U1F:

1. Wizt td, £ 2300 5 GCRFR A h SCRZES0), Bani £ ik g,
iy “OK”, i 3-1 flos.
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3 GOWIN MCU Designer %3

3.3 B Z%e

B 3-1 EBRREIES
Installer Language @

&dh Please select the language of the installer

i
a

[Simpliﬁed Chinese v]

[ oK ] [ Cancel ]

2. #HEFET, Bl NP7, WK 3-2 fors.
32 REMEZ
W GOWIN MCU Designer o] @ =]

o %ﬂ{{ﬁa GOWIN NCU Designer %%
I'._ u

%Aﬁeﬁﬁa%m’v%ﬁﬁ GOWIN MCU Designer HIER3EH

B

BE [T—H W] #Hik-

T=EE> [ mEo |

3. VFRLEPMY, iy “EFARE”, WK 3-3 fros.

& 3-3 FFRTIETMY
W GOWIN MCU Designer (o || = | = |
PFalubth 3 o)
TEEE GOWIH WOV Designer 7Hl: TEHENIEMED - W

LR RRIERSS 8 (Peinl {EFEE®E-

END USER LICENCE AGEEEMENT FOE GOWIN SOFTWARE INSTALLATION -

The terms and conditions that follow and any other terms that are
specific terms relating to thiz software("Software™) zet forth a legzal
agreement ["Agzreement™) between wou (either an indiwidual or an entity)
and Guangdong Gowin semiconductor techmology co., LTD. ("Gowin
semiconductor™).

Tou should carefully read these terms and conditionz of the J\g;reement

-

-

3?[1%1 %F‘qﬁ}wdﬂﬁ’huw $Eﬁ [ikﬂg‘ (1] dgdrdt. ’L’ ﬁ%‘%’qﬁ}u{?} LA

H MCU Designer =

KE—fw| #EED | [ BEO |

4. EFFHMH MCU Designer, ZiERINKE, Hidi “TF—

7N o

SUG549-1.4.1
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3 GOWIN MCU Designer %% 3.3 MR

B 3-4 i&FAH
W GOWIN MCU Designer =] = ==
BB ad
JEARITIEE AL GOWIN NCV Designer RIFFETNAL - W

giifhﬁﬁfﬁﬁﬁiﬂf‘—‘rs HEFAA LRI AN B [T—H W] 4

SRR it

FTETEE: 2.5 6B

fE—#®|T-4%w> [ mEo |

5. MEFEARATE, Bl @A, BOANLEALE CA\GMD, & 3-5 .

35 IEFRRNE
W GOWIN MCU Designer e = e
RERELGT M
THSE GOWIN MCU Desizner EXrdtpisrifst . w

s P AR D, R v

Biraitk
C: \GHD ST B

FRE=TE: 2.5 6B
TJFZIE: 51.7 GB

fEk—#$o| %o | [ B&Eo |

!
GOWIN MCU Designer V1.1 fiA, et B AR B e 36 H 3% .
6. MCU Designer %3¢, 6% %, W& 3-6 fix.
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3 GOWIN MCU Designer %% 3.3 MR

[& 3-6 MCU Designer % i#12

W GOWIN MCU Designer = @ || =2
ERE a&d
GOWIN MCU Designer [EEER8E. [HHFR- w
$HET: cdt_update install new sites. png .. 100%
Lol
$HET: cdt_t_proj_new with template 5. poe. .. 100% -

AT edt_t_proj_new with_template B opng .. 100%

$HED: edt_t_toggle_selection. pne. .. 100%

$HET: edt_t_toggle_selection?. pme. .. 100%

AT cdt_t_toggle_selectiond pme .. 100%

$HED: edt_toolbar. pnz. .. 100%

{HEY: edt_update find-install. pne. .. 100%

JHAT: cdt_update_install cdt_site pmg .. 100%

JHED: edt_update_install_new. pne. .. 100%

$HET: cdt_update install new_sites. png .. 100% -

CEEE (T > ELH )

7. MCU Designer 2358 i), 1EFESE 0 2228505 =77 7 H A3 I sh 4t
ARM MCU debug driver (SEGGER JLink). k£ %, NJT45 ARM
MCU debug driver (SEGGER JLink)Zz 35 #HfE . SR AN B 228, 5
% GMD 3t #2, sy “5Ea”, il 3-7 s

[# 3-7 ARM MCU debug driver R¥i%#

W GOWIN MCU Designer =] = | =

P IEfE5ER% GOWIN NCU Designer %3¢
[1]

GOWIH MCU Tesigrer 4 THI R
B ) K

[VISEH HWET debug driver [(SEGGER JLink):

<F—%m LA ©)

8. ik 2% ARM MCU debug driver (SEGGER JLink), I 4f 4235
SEGGER J-Link Xz 4, #.idi “Next”, il 3-8 Fizn.
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3 GOWIN MCU Designer %3

3.3 BfF ik

B 3-8 J-Link 22 HS

Embedded
Studio

Powerful C/C++ IDE
available for

= Windows
= macOS
= Linux

Download Trial

9. J-Link IRBNLEEVFRIIEYML, Hif “1 Agree”, WK 3-9 Ak,

' SEGGER - J-Link V6.49¢ Setup

e ==

Welcome to SEGGER - J-Link
V6.49c Setup

Setup will guide you through the installation of SEGGER -
J-ink V6.49¢.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue.

e
SEGGER

[ 3-9 J-Link 23 VFAEHMY

[EJ] SEGGER - J-Link V6.49¢ Setup

3 4]

g

C

Embedded
Studio

Powerful C/C++ IDE
available for

= Windows
= macOS
= Linux

Download Trial

License Agreement J
Please review the license terms before installing SEGGER - J-Link V6.49c. Link

Press Page Down to see the rest of the agreement.

Important - Read carefully: -

DEFINITIONS:
For the purpose of this agreement, the terms shall have the following meaning when the
entire word is marked bold:

The "software™ means all 3-Link related software components incduded in the J-Link
software & documentation pack provided by SEGGER which can be downloaded at:
http: //www.seqger.com/ilink-software. html

W:icensor' shall mean SEGGER except u_nder“th_e following drcumstances: ) -

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install SEGGER - J-Link V6.49¢c.

< Back 1 Agree Cancel

10. J-Link IR 2H44-1% £ . “Choose destination” 11, i%it#f “Update
existing intallation”, HARIETIE I EINIZE, Hi “Install”, W& 3-10

FIT7s o

3-10 J-Link 4HHiEEE

Kl SEGGER - J-Link V6.49¢ Setup

loT

Discover SEGGER

solutions for the
Internet of Things

Learn More

11. J-Link B¢z 2223 56 ik, Hidr “Finish”, 0B 3-11 fios.

SUG549-1.4.1

Choose optional components J
Choose optional components to be installed. Link

Install USE Driver for J-Link (requires admin rights)
Create entry in start menu

Add shortcuts to desktop

Update DLL in other applications (requires admin rights)

Choose destination:
2 Update existing installation
[ Install a new instance

Select:
(@ Instal for allusers () Install for this user only

Destination Folder

C:\Program Files (x86)\SEGGER \ILink

Browse...

[ <gak || dnstal ] [ cancd |

10(29)




3 GOWIN MCU Designer %% 33 MR

& 3-11 J-Link RE5ER

SEGGER - J-Link V6.49¢ Setup = B[ R

Completing SEGGER - J-Link
V6.49c Setup

The latest version of the J-Link Software & Documentation
pack can be found at the location linked below.

J-Trace PRO

Trace and Debug
in Real Time!

= Streaming Trace \
= Live Profiling }
/ SEGGER J-ink Software & Documentation pack

= Code Coverage

Learn More

3.3.2 Olimex AR HB BN H R ERIE

BRMEH Olimex 18R 17 E#:1F N Gowin_PicoRV32 3476 £ i 4
FLA% (EUfE ] RiscV 15445 42 kb T8 88 S 45 i Hodth 8 R il 45 188 .

Olimex i (7 2L ES TRAH I , (P 7ELE AR 22 Ik, e et Fep
(555 PC HLI IR

%% Olimex AT H A KAy, BT
1. %%z Olimex i {/ 7 #% USB Cable 5 PC #l.

2. & GMD % %5842 driver SCfFJ, X zadig-2.5.exe, T Olimex i
RO BRI, WK 3-12 Fir.

[ 3-12 Olimex B T ELBRIR 4R {4

¥4 Zadig == ==

Device Options Help

=) CEdt

Driver WinUSB (v6.1.7600.16385) = More Information
WinUSB (libusb)

UsBID libusb-win32
5 Install WCID Driver ¥ libusbk
WCID = WinUSB (Microsoft)

No new version of Zadig was found

3. EESEHE “Options > List All Devices” %3, 1K 3-13 fis.
[&] 3-13 fig & List All Devices &I

Kl Zadj o] & sl
Devic _thions Help =
List All Devices |
| Ignore Hubs or Composite Parents | B Edit
| ¥ Create a Catalog File
Driver /| Sign Catalog & Install Autogenerated Certificat < I"f]”mam"
ign Catalog & Instal ogenerated Certificate A
I=:3 Advanced Mode libusb-win32
weo| Log Verbosity » Kb

WinUSB (Microsoft)

No new version of Zadig was found

SUG549-1.4.1 11(29)




3 GOWIN MCU Designer %% 33 MR

4. iEH¥ List All Devices w55, 1 LAE 22417 PC MLT A &R %%, ik
% “Olimex OpenOCD JTAG ARM-USB-TINY-H (Interface 0)”, #n
K 3-14 Fr7R.

3-14 g B % % A Interface 0

K Zadig =

Device Options Help

[0limex OpenOCD JTAG ARM-USB-TINY-H (Interface 0)

v | Edit

Driver  libusbK (v3.0.7.0) WinUSB (v6.1.7600.16385) = HMore Information
WinUSB (libusb)

USBID 15BA 002A 00 libusb-win32
= Replace Driver v libusbK
wci X WinUSB (Microsoft)

4 devices found.

5. FCEIKSHSMET, HikF “libusbK (v3.0.7.0)7, W& 3-15 iR,
3-15 BL B Rz 3EH
[ Zadig ol @ =

Device Options Help

[Olimex OpenOCD JTAG ARM-USB-TINY-H (Interface 0) v |7t
Driver libusbK (v3.0.7.0) libusbK (v3.0.7.0) : More Information
WinUSB (libusb)
USBID 15BA 0024 00 libusb-win32
5 Reinstall Driver v libusbK
wecn? X

WinUSB (Microsoft)

4 devices found.

6. Hiil; “Install Driver” m% “Reinstall Driver”, J1f%%E Olimex Vit &
AIRB AL, Wl 3-16 Fiw.

3-16 &% Olimex HiR A AW ENERE

¥4 Zadig ol @ =4

Device Options Help

Olimex OpenOCD JTAG ARM-USB-TINY-H (Interface 0) ~ | edit
Driver  libusbK (v3.0.7.0) fibusbK (v3.0.7.0) > More Information
WinUSB (ibusb)
USBID 15BA 0024 00 libusb-win32
5 Reinstall Driver v libusbK
wem s X WinUS8 (Microsoft)

Driver Installation: SUCCESS

!

Olimex i 1017 AT IKBN BT, MRS T8 T7 3, G 23R ReF PC HLEKRPIR

7. Olimex 107 B 25 WX B 22 35 32, VMO %5 4FF, Interface 0 W& %
ERRIE, Wk 317 Fios.

SUG549-1.4.1 12(29)
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[&] 3-17 Interface 0 & ZFRERTY

Ed Zadig = 3=
Device Opti
Driver Installation
Olimex Operl .0. The driver was installed successfully. v |[[Edit
Driver libu lormation
Close bush
USBID 15§ 32

S Reinstall Driver IV libusbK
wem = K [_ ] WinUSB (Microsoft)

Driver Installation: SUCCESS

8. “Olimex OpenOCD JTAG ARM-USB-TINY-H (Interface 0)” 3% I
&, B RETIRPILEFERS “Olimex OpenOCD JTAG
ARM-USB-TINY-H (Interface 1)”, & 3-18 fii .

3-18 BLER&AIER Interfacel
&4 Zadig =lli®

Device Options Help

1
I [Olimex OpenOCD JTAG ARM-USB-TINY-H (Interface 1) 37 l: Edit
J

More Information

= WinUSB (ibusb)
USBID 15BA 002A 01 libusb-win32
5 Reinstall Driver E| libusbK
wem? K —— WinUSB (Microsoft

Driver Installation: SUCCESS

Driver  libusbK (v3.0.7.0) libusbK (v3.0.7.0)

9. HEEPITHES~7, 23Hik% “Olimex OpenOCD JTAG
ARM-USB-TINY-H (Interface 1)”.

10. B2 % “Olimex OpenOCD JTAG ARM-USB-TINY-H (Interface
0)” #1 “Olimex OpenOCD JTAG ARM-USB-TINY-H (Interface 1)”, PC
ML & ] BLIE# SR libusbK USB Devices > Olimex OpenOCD
JTAG ARM-USB-TINY-H (Interface 0)# Olimex OpenOCD JTAG
ARM-USB-TINY-H (Interface 1)

SUG549-1.4.1 13(29)




4 GOWIN MCU Designer F /= i

4.1 bRgiAs

4 GOWIN MCU Designer AR H

4.1 FRREF=

4.2 SRR

SUG549-1.4.1

GOWIN MCU Designer ¥ {4 P Fifan &l 4-1 fizs, 325 NbrdiF
(Title Bar). 242 (Menu Bar). T HA~ (Tool Bar). TiH %HE #2541
K| (Project Explorer View) . {4445 75 (Code Editor). %l £ 1 &l (Console
View). C/C++#EME (C/C++ Perspective) %5,

41 RERPAE

# C/C++ - om1 led/USER/main.c - GOWIN MCU Designer - o X

File Edit Source Refactor Navigate Search Project Run Window Help

Hmid [ Br&-@Bin|Sitiliis-in P - - C/Ct+
[ Project Explorer &2 9% ¥ = 8 [8mainc X =8 =g
13 bk_with_enroll_manufacture_GW1NSER_4C A N Copyright ((42014-2821 GowX Semiconductor Technology €g.,L8d.[ ~ TR
3 bl with_no_enroll_GWINSER_4C iy Includes <mmmmmem o Ngeme e Mmoo ey GOWIN_M1.h
O cm1_ahb2_ex 15 #include "GOWIN M1.h" ++ GPIOInit(void) : void
J cm1_aph2_exi e | Tool Bar + delay(volatile uint32.1)
3 eml_can e N e main(void) : int
- 18 void GPIOInit(void); Title Bar ol ‘
O cm1_ddr3 19 void delay(_ I0 uint32_t nCount); e GPIOIit(void) : void
& em1_dualtimer 20 | o © delaylvolatile uint32.1)
3 cmi_ethernet 215 dnt main(void) Menu Bar
1 em fatfe 823 systemInit(); t C/C++ Perspective
7 cm1_freertos 2 GPIOINit();
O emiize while(1)
3 cm1_keyscan {
5 em_led 28 GPIO_WriteBits(GPI0B,8xE);
[ cm1_led_boot_embflash o delay(4223000);
O em1_mm GPIO_WriteBits(GPIOB,8xD);
I cml_nvic delay(4333088);
& em1_psram En GPTO_liriteBits(GPIOB,BxB);
I em_retarget 35 delay(4333000);
1J cm_retarget_boot_embflash
GPIO_WriteBits(GPI0B,8x7);
I cm1_retarget_exddr3 38 delay(4333000)
O cml_rtc 39 } .
pp— 20 } Code Editor
3 em1_spi_flash L M . R
0 cmi_systick
3 cm1_timer n . & Console 2 o rf-r=0
- Project Explorer View ‘ o =
0 eml_trg No consoles to display at this time.
©J cm1_vart

€7 em1_uart exddr3
J cml_uart0_irq

7 em_ucos i

7 em1_watchdog

I cm3_ahb2_exi

7 cm3_aph2_exi

0 cm3_free_rtos v

\

Console View

0 items selected

SEETLAEREAR . SR RTIT T I SO AR

AY
FEER

— e

TERME R S R UL TR A s TH, 645 File. Edit.
Source. Refactor. Navigate. Search. Project. Run. Window £l Help &

FRLII

14(29)
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4.2 FErpt

SUG549-1.4.1

4.2.1 File LT
File ¢ H.I0, 14K 4-1 Fiur.
% 4-1 File 3EHIR
ST TN PR T VIRedIR
Makefile Project with B S makefile ) C/C++
Existing Code pRE|
C++ Project BrEC++IiH
C Project HrEECIHiH
C/C++ Project FrEEC/C++I H
Project... WrEC. C++. CIC++IiH
Convert to a C/C++ ;
. JECIC++I1 H AN CIC++EE
New Project(Adds C/C++ | Ajt+Shift+N i ﬁﬁEC/C:-l-IE%‘i
Nature) ’ -
Source File HrdC/C++HRRY
Header File HrEC/C++k et
File from Template HrECICH+BIAR S
Class HrEC++245HY
Source Folder IR AR S
Folder B Sk
Open File... - - FIHF CAELE S
Open Projects from B B . .
File System... RS2 ATH 7] S
Close - Ctrl+W KABAT Jmti 75
Close All - Ctrl+Shift+W KUAFTA w25
Save - Ctrl+S PRAFIUAT Y 28 1 N 2%
Save As. . B B u%ﬁﬁ%ﬁvﬁfﬂﬁéﬁﬁ:ﬁ&
1) N 2%
B . TRAF HT A Yt 2 10 N 25 DA
Save All Ctrl+Shift+S o A A
Revert B ~ BT A TN B R
N EPRAF RS TR N 2
Move... - - FE Bl YR
Rename... - F2 iy 44 TR
DAAHIARY 28 22 Ge K HOp 8
B BRI T RIS, R A
Refresh > RS, WAE
PR A IE .
Delimiters To Unix - Unix R Fi & 24
Print. .. - Ctrl+P FTENBUAT G s R A 25
NE &3
Switch Workspace - - ﬁ]?ﬁ%%f FITAFGFHER
TIER
_ _ H J§GOWIN MCU
Restart Designer IDE
15(29)
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4.2 FErpt

SK TR e P TT Dife ik
Import... - - STH [5
Export... - - FHIUE A5
Properties - Alt+Enter T H Je P
4.2.2 Edit SRR
Edit ST, 413% 4-2 s .

3R 4-2 Edit FLHATY

ST P e dtiik

Undo Ctrl+Z PR G s P B R — IR

Redo Ctrl+Y P B AT

Cut Ctrl+X B

Copy Ctrl+C =h

Paste Ctrl+V R G

Delete Delete I 4% 39 5 SCAR BTG 3R IR T

Select Al Ctrl+A WEEPTA (iR s N A

Find/Replace Ctrl+F /BB

Find Word - A H RIS

Find Next Ctrl+K AR H AT ST — M AR

Find Previous Ctri+Shift+K | &4k H 7 ik SCr i) E— M8 S 45

SUG549-1.4.1

Incremental Find

Nt Ctri+J AR AR, BB T ML AR
moremental Find | Girl+shiftrd | s i EHBE, R E— 035
Add Bookmark... | - o H MBSO e 114
Add Task... - 9 5 3 P 25 2 Sl
Doointon” F2 P93 R R BT b L
. BT BLELIF I Y2 SR, R
Content Assist Alt+/ AR T B 0 A
AR T B LR, BT b
Quick Fix Ctrl+1 LB IS A A REHE,  $R AT RER B 1Ty
‘220
N — \AA >y 72% ¢ 72%», \;‘ N
Sarameter Hints | A+ AR T TSI SRR, W3

BT B RS HEERER .

Set Encoding

DI 3 AT B 307 AR B RS

16(29)
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4.2 FErpt

4.2.3 Source SEHIN
Source JEHTN, U1 4-3 iR,
&R 4-3 Source SEEI]
SR Pt 7 xR DhRe R
Toggle Comment Ctrl+7 FvE N IRAT e B T BT AT
Add Block Comment Ctrl+Shift+/ PRy N S BT I BRI X B
Remove Block Comment Ctrl+Shift+\ HUOEARTE N & BT IR BT X B
Shift Right - 40 B 0 BT IE AT I 482 IR
Shift Left Shift+Tab > H FT AL AT N 4 E IR
Correct Indentation Ctrl+| Yt B0 N 2 B R RTIE AT
Format Ctrl+Shift+F AJ A F AR AR A% 2 28 SR BEE B Rl SOk #
T A% 2
Add Include Ctrl+Shift+N A HTBIATER R S R 5] A
Organize Includes Ctrl+Shfit+O 9 B AT ATk g ik e S 5
Sort Lines Ctrl+Shift+S R4 T8 € T, HEP R B I .
Implement Method... - B B ST S A () T
gggg::te Getters and - FIAT A ()7 BT Getters Al Setters
Surround With Alt+ShiftsZ gﬁﬁﬁiﬁ RIRIR R, PEAS BT AT D6 2009 38 21 1) S IR
4.2.4 Refactor SEBIR
Refactor 280001, WK 4-4 FiN.
R 4-4 Refactor SEHIR
SEHLIN Pt 77 TIREH IR
Rename... Alt+Shift+R HEIf AL iR, FHFHEH I CRNATE SR,
. . B E, RS HATHTERIER, FEkiERE
Extract Local Variable Alt+Shift+L TR By A ) 2
MBIk IA R P 3 T static final B BB S
Extract Constant... AltrC B, TS A LA A R
. . BANHREL RS HATHTEESR), R kR
Extract Function... Alt+Shift+M B i RS
. . P35 52 F BRBUE SO S (s LI R ERAMNER D
Toggle Function Alt+Shift+T B SIS, B .
Hide Method... - AL 51k
Apply Script... - N H CRAF I E A 51 R
Create Script... - SHOBRKERIIER, fESH.
History... - ATV AL Rl
SUG549-1.4.1 17(29)
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4.2 FErpt

4.2.5 Navigate SREIJ
Navigate SZH.I0, WK 4-5 FiR.
& 4-5 Navigate LI
ST TS HLI PaETT etk
Go Into - - LR NSE PN SR il pvd i v
Back ~ E—0 BB A BCEE IR TR E— M
E.
Forward _ T KRR BOE AR IR R — MR
Go To t.
Up One Level | - R BT 5 N\ BE RN R B
tH b
Resource... - PYE DA B, AR IUAT IR R .
_ .7~ Open Declaraction JE#EXTEHE, LAETESw
Open Declarat - F3 £ ar
pen Declaration 58 o P .
. B AT EAT B ARSI I B 2 I o s, FREAE
Open Type Hierarchy F4 Type Hierarchy ¥ T 8 %752 .
. B TEE R IAT R ARSI I B2 K TR, I
Open Call Hierarchy Ctrl+Alt+H 7E Call Hierarchy YL T B %00 2 .
Open Include Browser | - Ctrl+Alt+] 7~ Include Browser X% HE
. L7~ Open Element EFEXTIEHE, DAMEAE iR
Open Element... - Ctrl+Shift+T | 7 PN E
P IR AT
Open Type In ~ Ctrl+Shift+H 27~ Open Type EHEXT1GHE, DMEEREE S
Hierarchy... Type Hierarchy #LE s i — 2K,
Open Elementin Call | _ ~ 27~ Open Element EFEXIGHE, VAELEGmH AR
Hierarchy... 5 Call Hierarchy ML JF 5 — TG %K
Open Resource... - Ctrl+Shift+R | ZIR T IR
Ep)gf[g:lesm {7~ Problem Details 71 &
g‘rcoltjvizr 7% Include Browser #1 [
CIC++ o .
Show In Projects Altsshiftw | - SO+ Projects B
E)r:gli (r:':[ar .7~ Project Explorer #1L1&]
Eigce)p;r 7~ System Explorer 41 &
Properties .7~ Properties #1L &
Quick Outline - Ctrl+O v H AR 2RI S Quick Outline
Next Annotation - Ctrl+. EER — A ]
Previous Annotation - Ctrl+, b )
Last Edit Location - Ctrl+Q N HTOR A R B AL B
Go to Line... - Ctri+L TEREXPIEHE, DU AIR R4 N R IAT 5
SUG549-1.4.1 18(29)
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4.2 FErpt

SRHLII

PREETT

The g

Back

Alt+Left

AR AR GRS A AL A HT S B

Forward

Alt+Right

AR Z AT Tt AR AR

4.2.6 Search SEHBIR

Search Z LI,

n# 4-6 Fin.

% 4-6 Search SZHTIR

SEHLI

PREETT 2

Thre ik

Search..

T

Ctrl+H

=R

File...

192 File

C/C++...

142 C/C++

Remote.

142 Remote

Text

Workspace

Ctri+Alt+G

FEBAN TAEX R ik TR

Project

FEAE T TR M H i
HPTE TR

File

FEAL S PN e R K S 4
Rk n R

Working Set...

fE TARSE TR TR

4.2.7 Project JZEATR

Project > HL.Ii,

= 4-7 Pr

oject SEEAIN

n# 4-7 iw.

SRHLII

T LI

PREETT

Thae g

Open Project

WRXEAE, JEBUTE
KHIA o

Close Project

ST H AT P B 5 H

Build All

Ctrl+B

Xt AR G KA BT H 3k

740

Set Active

& Release ¥ Debug
NIEEPIRES

Manage...

EHEAE

Build Configurations

Build by Working Set

BCE G LA

Set Active by Working Set

wE TARENESIRE

Manage Working Sets...

EH TR

Build Project

Xt H AT BRI H AT 1
Y

Build Working Set

Select Working Set

X LA 1
(R

Clean...

TR LS

Build Automatically

H a3l ik TAEX T

SUG549-1.4.1
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4.2 FErpt

ST e AT DhRefiR
i H
Create... fenlfz:S
Build Targets Build... Shift+F9 Yn ik
Rebuild Last Target o P H bR
Properties - JEMERCE
4.2.8 Run SEHRIJ
Run SZ5.00, W15 4-8 Fiw.
7 4-8 Run JTHIR
S EAT AT e stk
Programmer J& 3l # At Programmer
Debug F11 Ja SRR
Debug History - A5 FH P skl s b o s — R R UG B
Debug As - J& B I HE [ PR 7
Debug Configuration... - Pic B A T T 5 3 i
Toggle Breakpoint Ctrl+Shift+B R AT ES, BTG B BRI A
Toggle Line Breakpoint | - YT PATACEAT, i A BRI .
Toggle Method B PRI T D7, BTG BOR B W
Breakpoint o
Toggle Watchpoint - HRTTB, WGBS .
Skip All Breakpoints - R A XA B s
Remove All Breakpoint | Ctrl+Alt+B TR MR AR X B A W e
- _ fic & W7 5257 (C/C++ Breakpoint 5%
Breakpoint Types C/C++ Dynamic Printf)
4.2.9 Window IR
Window LI, WIEE 4-9 FR.
& 4-9 Window EHIR
ST TSI PR ThRefhik

New Window

RS IEEE R, Hhga
5 BT IE AL AR BE L

Edit

Toggle Split Editor (Horizontal)

Ctrl+_

BRI F T T4 3 i 4 T A

Toggle Split Editor (Vertical)

Ctrl+(

3 ELFT T 2h G S 45 8T Bl A

SUG549-1.4.1
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4.2 FErpt

ST T EIN PsE 7 = Difefinik
Clone - ST B i A R L A
Hide Toolbar - Beget T A
Appearance N
Toggle Full Screen Alt+F11 ENSIPS
Build Targets - 7% KRR Build Targets ML
C/C++ Projects _ éﬁﬁiﬁ‘%ﬂ@qﬂﬁ% C/C++ Projects 41
Console Alt+Shift+Q,C | 4 HTZEALE 1 57~ Console #E K]
Documents - MHTEALE %2R Documents
Include Browser - %ﬁﬁ@m@qjﬁ/% Include Browser
ML
Navigator - MHTEE A 2R Navigator
Outline Alt+Shift+Q,0 | 4 HTEML K H &< Outline
Show View s — o
Problem Details B AT IZE AR K 27 Problem Details £
Problems Alt+Shift+Q,X | 4 HTZEM K 7R Problems #1L K]
Project Explorer _ gﬁﬁ@%ﬂ Hh 7R Project Explorer 1
Properties - Y777 E T 27N Properties #E K]
Search Alt+Shift+Q,S | X4 ATIEL & ik Search #1LE]
Tasks - HHTELE 2R Tasks #LE]
Other... Alt+Shift+Q,Q | T HTH MK
Open Perspective - IR
Customize Perspective ... - B Y FE L E & Ao R T L
Save Perspective As... - W 4175 L A7 T A R
Perspective o s
Reset Perspective. .. - IR A € SZE AL E
Close Perspective - KAESNEME
Close All Perspectives - KA A E
Show System Menu Alt+- BIRRGH
Show View Menu - NS
Quick Access Ctrl+3 TF 8 PRV ) e
Maximize Active View or Editor | Ctrl+M B KA AL B 4
Minimize Active View or Editor | - e/ TR B B 2%
Navigation Active Editor F12 J& B2 A
: JE BNl {5 R 4 2T R ) R —
Next Editor Ctrl+F6 i ;;iﬁ %%”ﬁ B
. . . A S AP L
Previous Editor Ctrl+Shift+F6 E#Eg%gg@ﬁiﬁ%ﬁﬁi* &
Switch to Editor... Ctrl+Shift+E | YJ4 2| I A H g A%
Next View Ctri+F7 JE By el {5 A BT B b ) R — A
SUG549-1.4.1 21(29)
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4.2 FErpt

SE LI T Py = DhRefiik
VAN EL LS
. . . Ja Bl Bk AL S A i B A
Previous View Ctrl+Shift+F7 R L
. Ja S BGEAEH FE M EE A N —
Next Perspective Ctrl+F8 AT 3 HL
. . . Ja SR rE M EE A b —
Previous Perspective Ctrl+Shift+F8 AT 3 HL
Preferences - ~ fic & [T TAE Gk
4.2.10 Help 8T
Help 25000, N5k 4-10 Fios.
3 410 Help 28R
S LTI Sk DyRe ik
Welcome - SR g AR
Help Contents - SN B U B AL P
Search - 192 Help W%
Show Contextual Help - {7~ Related Topic H[1) Help P %
Show Active Keybindings... | Ctrl+Shift+L B RIE B P
Tips and Tricks... - A HARIRZE A= 1R 5 R
Cheat Sheets... - T I e BUHR B 0 T AE
License Content - 7R License 15 &
gzgilgncgfwm MCU {7~ GOWIN MCU Designer {5 &
FSE AL “Help > Help Contents”, AT LL#EE GMD.
Gowin_ EMPU(GW1NS-4C). Gowin_EMPU_M1. Gowin_EMPU_M3.
Gowin_PicoRV32 S£H P F M, Wil 4-2 fiis.
SUG549-1.4 1
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4 GOWIN MCU Designer F /7 5 4.3 THF
[#] 4-2 Help Contents
& Help - GOWIN MCU Designer - ] »
Search: Scope: All topics
Contents G- | ¥ B u] o f|gell& B

= @ Workbench User Guide
n @ C/C++ Development User Guide

=
= [H GMD
Contents
# [ Gowin_EMPU{GW1NS-4C)
# [ Gowin_EMPU_M1 + GMD
# [ Gowin_EMPU_M3 —
® [ Gowin_PicoRV32

GOWIN MCU Designer Guide

« Gowin EMPU(GWINS-4C)

= € RSE User Guide + Gowin EMPU M1
+ Gowin EMPU M3

+ Gowin PicoRV32

m
iy
3

&

4.3 THE#=

FER A DR PUE YT RN, R AR HrE e TR
(New). {Rf73CHF (Save). fRAFFTA M (Save AlD . BLEEH (Manage
Configuration) . %% (Build/Build All) . %% (Programmer). i (Debug) .

2% (Search) 5§, W% 4-11 s,

* 4-11 TREER

T HA= T WwWibRE | DiReiiR

New .- BrE&mH TR S

Save (=] TRAEIAT Y4B 25 (1) N 25

Save All =) LB 24 FR ORAF AT G SR 1) A
Manage Configurations ® v fid B ¥ (45 Debug fil Release)
Build ] ~ XoF I B 3T H AT 3 g
Build Al 01 Xt AR G R B T BT 1 R
Skip All Breakpoints L1 VAR AR P 2 TAE X BT W7 A
Restart # J5 GOWIN MCU Designer IDE
e ool #y I ARM ALFE 55 14

Debug - 7Y

Programmer W J2 5 Programmer T #;

SUG549-1.4.1
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4.4 T H FIRE B AL

T RFIED bR E | DhReHIA

Open Element - B E)pnen Element i%i‘%iﬂ‘iﬁli, PAfSE
FEgEE A I — TR

Search ¥ MR

Toggle Mark Occurrences g FFK CIC+H+gmR A bric ok

Toggle Work Wrap Tl R A AT

Toggle Block Selection Mode B TFRPE Pk 5 2

Show Whitespace Characters | |1 iR A BN H AT

Next Annotation ¥ - IR — A i) g

Previous Annotation g v JEE_E—AN )

Last Edit Location ¥ RIRETIRR A R A B

Back . fﬂﬂ%‘zﬁﬁﬁ%ﬁiﬁ%ﬁ*ﬁm%ﬁﬁ—ﬁ\
7

Forward (= SRR Z HT 484 Frid i ROR

14 B H#REESE
R TR N A S S A EoRThRE, T E R REE I TR
FrerE A
4.5 KB 4miE e
PRI B SO e 2 B DR
7t File & THT G BFT IF B SO AT B 7 SCAR G [X o
FLTESEHAE “File > Close” 328 T B, S A g 45 X 24 T 7 SO 44 45 )

“CHR 7 LSRG IX N 2 FT s ) S
A “File > Close All” 3T, |2 5¢ A SCA g 45 (X N 2.7 1 i
H XA
4.6 ITHIE M E
SR TR A G R, AR P #bR S 0 E AN E SR ) f
lﬂ{%‘l%\:

® x|l GfE L

® [1fi{Z 2T (Problems 1)

.7 (Console 1)

SUG549-1.4.1 24(29)




5 License & ¥ 5.1 License Hi#

License B

5.1 License HiF

GOWIN MCU Designer %3 58 U5 1 XA 311, 23878 23573 Mt License,
GOWIN MCU Designer E XA 80T, BkRm = FAE B34, HiE
License.

Hi¥ License, iFiRftun FE8.:
® HHEHNL MAC Ml (uhifk)
® HEHNLA (i)

5.2 License Z=3&

GOWIN MCU Designer %3¢ 52 a1 ) 3, #HECE License X iHHE,
PR P 2237 E M License, 1K 5-1 s

& 5-1 Bzh License IR

(-."" — ? " -
( ' Configure License e

® There is no GOWIN MCU Deisgner license installed.

Install now

Sy AT
SESAMSE

WA HiE License, B “Exit”, i 5 m =~ FAE 54 S AbEE 5,

& License.

SUG549-1.4.1 25(29)




5 License %31

5.2License &%

SUG549-1.4.1

W L HE License, Hidi “Install now”, § A\ 2 3REU License LA,
g “OK”, ¥ 5-2 fior.
& 5-2 License & 453 A

There is no GOWIN MCU Designer license installed.

Please configure an existed license file:

C:\GMD\gowin_mcu.lic v

Apply for license, please contact FAE/Sales.

Wl 5-3 iz, License Z23&7E M 5€ )G, $7 License 22 23E 4G UE %),
#id “OK”, Ja3) GOWIN MCU Designer.

[&] 5-3 License &1

:
ol

There is no GOWIN MCU Designer license installed.

Please configure an existed license file:

C:\G‘::“ - =
Y47 Manage License

APl | License verify successfully!
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5 License & ¥ 5.3License &

5.3 License &8
License Z|#ART, 7T HEHY) License #4755 22 25 4 it .
P S BES “Window > Perferences”, #TH Perferences XHEHE, #E+%
“License > Manage”, W] LA # ey ME#T ) License S, 4n& 5-4 fir
H—_\Ao

5-4 License &3
Ay Preferences l S | S f

type filter text Manage o v

» General .
Bleace denloy a lirancs fils

Automatic Updates
. CiC++ License file:  C\GMD\gowin_mcu.lic

> Help
2 Licenco Apply for license, please contact FAE/Sales.

Manage
> MCU
> Remote Systems
> Run/Debug

> Team

Terminal

€)) OK l l Cancel

5.4 License &F

LA License F 58k i M J » Hidi € Hi42“ Help > License Content”,
A LA B O BIEMR License (22, W& 5-5 s,
5-5 License &EH

% License l (=] ﬁ] )

Product: GOWIN MCU Designer

License Type:  Activation File
License Issuerr  Gowin Semiconductor
Expiration Date: 12019-11-21

Redistributor:  Temporary user

OK l ’ Cancel
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6 GOWIN MCU Designer # {1 6.1 ik LARNE

6 GOWIN MCU Designer X4

6.1 wWiFLEHAE

6.1.1 ARM MCU %i¥FT Bt =

1 ARM MCU 351 H TA2H, 2A3£84 “File > New > C Project” %
T.HA% “New > C Project”, ] New C Project XfifHE. “Project type” ik
## “Empty Project”, “Toolchains” iz “ARM Cross GCC”, i 6-1 it

ﬂ_\‘ o

6-1 ARM MCU #i¥ TRERE

W C Project [_@éj
C Project p—<p

Project name must be specified

Project name:

V| Use default location

CAGMD\workspace Browse...
default
Project type: Toolchains:
4 =, Executable ‘ARM Cross GCCi I
L & Empty Project RISC-V Cross GCC
® Hello world AR C Project

® Hello World RISC-V C Project
- = Shared Library
- [= Static Library
- = Makefile project

4 m 3

V| Show project types and toolchains only if they are supported on the platform

6.1.2 RISC-V MCU #wiFT E#iE

f]4 RISC-V MCU 5 H THER, Hidisg#A= “File > New > C Project”
;T HEE “New > C Project”, T/ New C Project XJi&itE. “Project type”
i%F% “Empty Project”, “Toolchains” i&#¢ “RISC-V Cross GCC”, 41| 6-2
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6 GOWIN MCU Designer #f4-ii ]

6.1 %t L AEEMCE

R
& 6-2 RISC-V MCU 4iZ T E$&fr =

W C Project

C Project

Project name must be specified

Project name:
Use default location
Location: | CAGMD\workspace

Choose file systern: | default

Browse..

Project type: Toolchains:
|4 (= Executable ARM Cross GCC
[ & Empty Project | RISC-V Cross GCC

& Hello World ARM C Project
& Hello World RISC-V C Project
I+ (2= Shared Library
[ (= Static Library
I = Makefile project

1 I | »

Show project types and toolchains only if they are supported on the platform
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